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Welcome to GoldMine
The following document includes important information, including corrections to the GoldMine documentation and supplemental information not available when the
documentation was printed. Please keep this document in a safe place and use it in conjunction with the GoldMine documentation.
1.

Please read the corresponding versions of the Compatibility Matrix and Installation Guides for GoldMine Premium and GoldMine Connect before installation. You
must install prerequisites and verify environment compatibility before installing GoldMine. Documentation is provided in the GoldMine download from our SelfService portal and is available in our Knowledgebase. See https://forums.ivanti.com/s/goldmine-premium-edition to access the GoldMine Community and
knowledge articles about GoldMine. For information about new features of GoldMine, please see the Release Notes. After installation, Release Notes are available
in GoldMine Premium Edition via Help >> Release Notes.

2.

If you are switching from GoldMine Plus for Outlook to GoldMine Link for Outlook or vice versa we recommend uninstalling GoldMine Premium and reinstalling
choosing desired Outlook option during reinstall. Please select to connect to existing database pointing to the shared GoldMine data folder on the server during the
reinstall.

3.

Beginning with GoldMine 2018.2 version we added as pre-requisites URL Rewriter for GoldMine Connect. When the installation process starts, the first step is to
perform a check to make sure this pre-requisites is installed on the system. In the case is not, the installer will download it from the Internet and install it. Due to
this it is necessary to have internet access while performing the installation, otherwise the installation will fail when the pre-requisites are not met.

4.

By default, some Windows Operating Systems may have the Use Unicode UTF-8 for worldwide language support enabled. This can cause unspecified errors
when logging into GoldMine or reviewing data. This setting should be disabled. Refer to https://forums.ivanti.com/s/article/When-logging-on-GoldMineUnspecified-error-and-thenincorrect-login for more information.

5.

When upgrading GoldMine Connect, the Identity User for the GMMobileAppPool will be reset to the NetworkService built-in account. Reset this following the
GoldMine Connect Install Guide.

6.

When installing or upgrading GoldMine Connect it is recommended to accept the default host name of localhost for HTTPS Binding Options. Binding Options
can be adjusted later in IIS.

7.

TRUSTSELFSIGNEDCERTIFICATES setting that is used for encryption of the database connection in the dbalias.ini is a general system setting. In case of
environments with multiple contact sets defined on different database servers please make sure that on each database server there is the same certificate
configuration (with or without certificate defined), otherwise there will be problems in connecting to the database.

8.

The read-only user needed for the SQL Query function is defined per database. In environments where multiple database aliases exist in the dbalias.ini file, please
make sure you have a read only user created for each database alias.

9.

Beginning with GoldMine 2018.2 version we added password complexity rules and password validation on login. In previous versions, passwords were saved in
the database using upper case letters. Existing users that do not change their password after the upgrade from a version previous to GoldMine 2018.2 must enter
their password using upper case letters at login in GoldMine Premium Edition or GoldMine Connect.

10. Beginning with GoldMine 2018.2 any integration passing the GoldMine password via the GoldMine API must be provided 'as-is'. In previous versions the
password was required to be provided in UPPERCASE.
11. In order for campaigns to sort correctly by Date Sent in Go To >> Campaigns >> Constant Contact Campaigns, ensure that Control Panel > Change date, time or
number formats > Administrative tab > Current language for non-Unicode programs matches the Format set on the Formats tab on all machines.
12. If you exchange iCalendar (iCAL) messages with Outlook users, please note that Outlook handles iCAL messages best when configured to use Internet Mode and
POP3 account(s).
a) Using Workgroup Mode or configuring Outlook to send/receive messages from a Microsoft Exchange Server only, may result in lost Activity details on
replies sent by the Outlook recipient or difficulties in the handling of replies to activities sent by Outlook users.
b) IMPORTANT: Differences in the handling of recurring activities may present problems when using iCAL messages. If exchanging recurring activities
with an Outlook client using iCAL messages, do not make changes to the activities once they have been accepted.
13. Synchronizing very large databases (approximately 20GB or higher) may cause GoldMine to run out of memory, if there is insufficient RAM installed.
14. In the current release of GoldMine Premium Edition, the Service module works only with a single contact database (i.e., the contact set alias must be identical to
the alias for the base GoldMine tables).
15. The Merge/Purge Wizard function "Prompt me before merging records" option may cause performance to slow and an eventual crash when the process identifies
and presents many duplicates. To avoid this, use a filter or group to limit the number of records being processed.
16. If you use GoldMine e-mail templates, please note that you cannot enable the Wrap Lines option to toggle it on/off.
17. When using an e-mail template created outside of GoldMine, replies to e-mail messages may have unexpected or inconsistent fonts. This problem can occur if the
fonts in the template are based on a style sheet, using the HTML <STYLE> tag. To ensure that your messages are formatted as expected, please ensure that each
paragraph of text within your e-mail template includes an inline font definition (using a <FONT> tag after the <P> tag in the HTML template, for example).
18. The Output To > Word feature currently does not work properly if Microsoft Excel is open. Please close Excel before using this feature.
19. When running a mail merge to a filter or group using GoldMine Plus for Microsoft, please do not switch between documents using the Word Mail Merge toolbar
while GoldMine is still merging documents. Switching between documents may prevent GoldMine from creating history records for one or more of the documents
that you viewed.
20. Microsoft Word Trust Center Settings may prevent you from opening or merging a GoldMine document template. To resolve this, add the GoldMine document
template folder (usually C:\ProgramData\GoldMine\Template) and subfolders as trusted locations in Word.
21. If you open a document in Microsoft Word while a different Word template is being previewed in the Document Management Center, the File menu in Word may
be disabled. You can use one of several methods to resolve this.
a)
b)

In Document Management Center uncheck option to preview templates.
Close the Document Management Center in GoldMine.

c)
d)

Disable the preview of Word templates in GoldMine, via Tools > Configure > System Settings > Preview.
Launch Word using the "/w" switch to start a new instance of Word. Please read the following article for detailed instructions:
http://support.microsoft.com/kb/210565.

22. The automatic login prompt for GoldMine Plus for Microsoft Word may interfere with the display of Word documents within Internet Explorer. To prevent this
issue from occurring, launch Microsoft Word and if a GoldMine login screen appears, check the box labeled "Don't show this dialog again".
23. If you have Microsoft Excel running with an Excel file open, viewing another Excel file within a preview pane in GoldMine may prevent Excel from operating
properly. If this occurs, change the view in GoldMine so an Excel file is no longer being previewed.
24. If an Excel file is displayed within a Preview Pane in GoldMine Premium, an attempt to merge an Excel document template (.xlt or .xltx file) may fail with an
error. To prevent this problem, please change the view in GoldMine so an Excel file is not being previewed before merging the template.
25. Macros recording or execution within GoldMine Premium may fail on newer operating systems. You may wish to rely on third-party macros recording utilities.
26. The Sync Contact setting in GoldMine Premium may result in slow performance. If this problem occurs, please turn off the Sync Contact setting.
27. If you schedule an all-day event and send a meeting request to a contact, the recipient's mail server may translate the request into a timed activity, using the time
zone of the server. If this occurs and the recipient's system is in a different time zone from the server, the times viewed by the end user will be offset by the time
zone difference.
28. When clicking a hyperlink in GoldMine Plus for Microsoft Outlook to update a recurring activity that was previously added to GoldMine, only a single occurrence
of the activity may be updated. To update the entire series, synchronize GoldMine with Outlook.
29. If attendees are added to an existing activity that was previously scheduled in Outlook and added to GoldMine, the attendee list will not be transferred until
GoldMine is synchronized with Outlook.
30. On some operating systems, including Microsoft Small Business Server 2011, Outlook synchronization requires GoldMine Plus for Microsoft Outlook or
GoldMine Link for Microsoft Outlook to be included when installing GoldMine Premium Edition.
31. If a one-time activity is created in GoldMine and synchronized to Outlook and then modified in Outlook to become a recurring activity, only the first instance of
the recurring activity will appear in GoldMine after synchronization.
32. The "Page Me" functionality that existed in some previous versions of GoldMine was replaced by Messaging features in GoldMine Connect Edition. To use the
"Page Me" feature without installing GoldMine Connect Edition, add the following lines to your user settings file (<username>.ini):
[GoldPager]
PagerEmail=1234567890@smsgateway_for_carrier
Replace the email address shown above as appropriate for your mobile phone service.
For assistance in determining the e-mail address, refer to https://forums.ivanti.com/s/article/How-to-add-othermobile-carriers-than-the-defaults-available-inGoldMine-for-SMS-Text-Messaging-capability
33. If you use multiple contact sets in GoldMine Premium Edition, the contact set opened for a user in GoldMine Web is the same one most recently opened by the
user in GoldMine Premium. It is not possible to change contact sets in GoldMine Web - the user must log into GoldMine Premium, open the desired contact set,
and then log back into GoldMine Web. Please note the following limitations in GoldMine Web related to managing activities that are linked to a contact that is not
in the active contact set.
a) SMS messages will not include contact-specific data if the activity is linked to a contact that is not in the active contact set.
b) Activities linked to a contact that is not in the currently open contact set will become unlinked if completed in GoldMine Web.
34. In GoldMine Web, custom labels for primary fields and Rule Based selection for custom screens are not respected when selecting "dBASE expression resultbased" and using an expression other than trim(key1) for the Record Type Rule.
35. In order to successfully view, update, or create data in GoldMine Web, it is necessary to run an IISRESET when the GoldMine database is rebuilt to add custom
fields or when a lookup.ini file is added or updated.
36. A maximum of the previous 20 days of emails can be retrieved into the GoldMine database when logged into GoldMine Web when the user's email settings are
configured for IMAP (recommended). To retrieve Inbox emails for more than 20 days, the user can log into GoldMine Premium. It is not possible to retrieve
emails from the specified IMAP Sent mailbox in GoldMine Premium.
37. When Replying to or Forwarding emails from GoldMine Web, a limited amount of the original message is available in the Reply or Forward. This is due to
limitations with some MailTo clients.
38. Notes in GoldMine Web are in plain text. When a note with formatted text is edited in GoldMine Web, the formatting in GoldMine Premium is removed.
39. If a field is configured as "Required Data Entry" in GoldMine Premium, there is no option to override this feature when a user edits a record in GoldMine Web.
40. If the "Attach this process to all new contact records" option has been set for an automated process in GoldMine Premium, the process must be executed within
GoldMine Premium after creating a new record in GoldMine Web.
41. Alarms sent as SMS messages are delivered when the system time on the server machine matches the time set for the alarm.
42. The City and State fields for a contact record are not automatically filled based on the entry of a ZIP code in GoldMine Web.
43. GoldMine Connect requires cookies to be enabled. If cookies are disabled or the Private Browsing option is used, you will not be able to log in and use GoldMine
Web.
44. An undocked user cannot login into GoldMine Web while already logged in to GoldMine Premium on a network and connected to the application server used by
GoldMine Web. The login will fail with a message "All GoldMine licenses are already in use."
45. In GoldMine Web, prices are not automatically populated when selecting a product while creating a forecasted sale, even if the lookup list for the Product fields
has been configured with a price.
46. dBASE expression fields are not displayed for contact records in GoldMine Web.
47. dBASE expressions are not available for selection in lookup lists in GoldMine Web.
48. The use of alphabetic characters in the Time field to schedule a prioritized activity is not supported in GoldMine Web.

49. If you create a forecasted sale in GoldMine Premium and relate it to an Opportunity, editing the sale in GoldMine Web will not update the close date or value of
the corresponding Opportunity.
50. Only the E-mail Rule actions "Move to Inbox", "File", and "File To" are respected when emails are retrieved into the GoldMine database while logged into
GoldMine Web.
51. To access Linked Documents from GoldMine Web, the document pointer must not be a mapped drive; instead use a UNC path. Existing mapped drive path
references can be updated using the Tools > Data Management > Move Linked Docs and Attachments feature in GoldMine Premium.
52. OAuth authentication is not supported for Office 365 Personal accounts with aliases setup.
53. If you want to use OAuth authentication for receiving emails and an alternate SMTP server please refer to https://forums.ivanti.com/s/article/How-can-users-use-aseparate-SMTP-server-for-sending-emails-when-using-OAUTH
54. If the GoldMine Plus for Microsoft Excel is not working anymore, instead of the value a #NAME appears, please refer to https://forums.ivanti.com/s/article/Afterrecent-Microsoft-Office-updates-the-GoldMine-Plus-for-Microsoft-Excel-is-not-working-anymore-instead-of-the-values-a-NAME-entry-appears-Usual-Registryfix-for-NAME-has-been-checked
55. Beginning with GoldMine 2021.2 version we added as pre-requisites Microsoft OLE-DB Driver fro SQL Server for GoldMine PE. When the installation process
starts, the first step is to perform a check to make sure this pre-requisites is installed on the system. In the case is not, the installer will download it from the
Internet and install it. Due to this it is necessary to have internet access while performing the installation, otherwise the installation will fail when the pre-requisites
are not met.
56. License Limits and Definitions
a) GoldMine Premium Edition is licensed per Concurrent or Named User: A Concurrent User is a license that can be used by any Authorized User, but
only by one at any given time. A Named User is a license that can be used only by a specific Authorized (i.e., Named) User. Each Named User created
for use in GoldMine subtracts one Concurrent User license. A remote user accessing the Licensed Software via a network connection to a centralized
GoldMine installation is considered to be utilizing one concurrent user license. A remote user or site accessing the Licensed Software in an undocked
scenario is considered to be utilizing one named user license.
b) You agree not to copy the Licensed Software except for backup and disaster recovery purposes, or as described in the accompanying Documentation.
c) Should You exceed Your licensed number of Users, then You agree to pay the full list price for the excess Users in accordance with the IVANTI then
current price list, as well as the full Maintenance and Support Fees related to these additional products.
Capitalized terms not defined herein shall have the meanings set forth in the applicable End-User License Agreement. These definitions are as of May 18, 2015.
57. Licenses
GoldMine Premium Edition 2019.1 and lower
If upgrading from GoldMine Premium Edition 2019.1 or lower, you will need a new license. If you do not have a new license, please see
https://forums.ivanti.com/s/article/How-to-Request-a-GoldMine-License-for-Version-2020-1-and-above-when-upgrading-GoldMine-from-GoldMine-2019-1and-lower before installing or attempting an upgrade.
58. Third Party Components
GoldMine Premium Edition may include the following and other components:
Sentry Spelling-Checker Engine Copyright © 1999 Wintertree Software Inc.
Apache Components. Copyright © 2000. The Apache Software Foundation. All rights reserved. GMPE includes software developed by the Apache Software
Foundation. Apache Software is subject to the conditions and disclaimers listed in Apache License v.2.0 found at http://www.apache.org/. The Software is
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
OpenSSL. Copyright © 1998-2008 The OpenSSL Project. All rights reserved. GMPE includes software developed by the
OpenSSL Project for use in the OpenSSL Toolkit (https://www.openssl.org/). The names "OpenSSL Toolkit", and "OpenSSL Project" must not be used to
endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl- core@openssl.org.
Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in den names without prior written permission of the
OpenSSL project.
GoldMine’s use of information received from Google APIs will be adhere to Google API User Data Policy, including the Limited Use Requirements.
If you would like more information about third party licenses, please contact your GoldMine sales representative.
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